Yeled v’Yalda Ink ∙ Fall 2006 / 

E M P L OY E E N E W S L E T T E R • FA L L 2 0 0 6

A

new year has started with a
hum of activity in all departments. Everyone is working diligently to get the year off to a great start
with continued success for YvY.
At Human Resources (HR) we
have met with many new employees from all sites and all departments. We welcomed them to YvY
and assisted them in completing
their personnel portfolios to ensure their getting onto payroll
promptly and efficiently.
We have notified all Head Start
sites and the various departments
of important information relating
to their needs; whether it is with regard to new employees, new regulations, child abuse prevention training, and necessary documentations.
(continued on page 2)

Did you win
the IPOD?
Find out on P
age 4!
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In
the

Sp tlight

Our In the Spotlight feature sheds light on different departments or events at
YvY. In this issue of YvY Ink, we visit the Yeled v’Yalda School.

I

t is with tremendous gratitude to
Hashem and to all of the Yeled
V’Yalda staff that we can finally say
“The Yeled V’Yalda School is up and
running.” Our center-based program,
located at 150 Chester
Avenue, just a hopskip-jump from Yeled
V’Yalda’s 37th street
building, is geared to
the needs of children
who learn best using an
ABA (applied behavior
analysis)
approach.
Consultants to the
school include Board
Certified Behavior Analysts (BCBA) from the Connecticut
School of Child Development and
Stein Lund, ABA specialist, of Contingency Analysis in Rhode Island.
Our speech therapists provide speech
and language therapy, and have considerable experience working with
children who need oral motor and/
or feeding therapy. The school also
provides occupational therapy with
a strong sensory component. Julia
Harper, a world renowned OT has
been flying in to consult with and

train the staff as well as to evaluate
the children. She has created individual programs for each child which
are being implemented by our experienced OT.

At present there are two classes with
five children in each. There is a minimum staffing ratio of one-on-one for
all children in addition to a certified
ABA trained teacher assigned to each
class. The children range in age from 5
to 10 years of age. Our daily schedule
includes time for one on one learning
using an ABA format, where complex
tasks are broken down into simple
steps. We also have group activities
that help the children generalize their
(continued on page 2)
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Spotlight (continued from page 1)
learning in a “realtime” setting, allowing them to carry over information
learned individually. Each class’s daily

schedule includes intensive sensory
activities for the class twice daily, in
addition to the individual speech and
OT sessions. At this time, because
the classes are running smoothly, we
would admit one additional student to
each class. To contact the new school,
call 718.851.0123.
The Yeled V’Yalda school has been
two years in the dreaming and creating
stage. It is finally a reality, the result of
hard work, intensive research and sleepless nights.

From the Desk of…
T

HRD (continued from page 1)
Yeled V’Yalda aims to comply with
all regulations and we all work hand
in hand keeping that goal in mind.
As Yeled V’Yalda grows, so do
the responsibilities and work in our
Human Resources Department.
Therefore, we have welcomed Roizy
Kuten to join our HR Department.
Roizy will be working together with
Tzivie and myself in ensuring that
all employee’s paperwork and necessary requirements are completed in a
timely manner. Roizy can be reached
at ext. 598. Welcome Roizy!!
As the year progresses and
new issues arise, remember that
Yeled V’Yalda’s HR Department
is always available to assist all
employees as best as we can.

he population of YvY children and families is exceptional in many different ways,
not just the sheer number of children but also the diverse and complex needs
that they are experiencing. These needs reflect national and international fast growing
problems. In Israel, in Europe, in Asia, in the US, current pressing issues include: how
to prevent the fast increase of obesity? How to ensure the success in the acquisition
Gitty Lichtenstein
of literacy and mathematical skills by all children, regardless of their home language
Director of Human Resources
backgrounds? How to slow down the spread of the epidemics of attention disorders?
Tzivie Marder
Although researchers work hard, debate fiercely and do not always agree on the
Asst. toDirector of HR
best solutions, all of them agree that in many different fields- psychology, neurology, psychiatry, education, linguistics, medicine, sociology etc-, since the 50’s there has been phenomenal progress in our
understanding of how children grow, develop and learn. Such progress has translated itself into a better understanding of the
prevention of problems before they arise and of the fostering of appropriate support when they cannot be prevented.
Unfortunately, researchers often work in the ivory tower of an isolated suburban campus or of a wealthy residential urban area. What that means is that children who need their expertise the most, i.e. children from low
income families, do not benefit from their advances. Bridges need to be built between the best researchers and
the most needy children and families: this will benefit the latter while validating the work of the former
— by investigating whether it can be applied to a broad range of socio-economic, ethnic, cultural and
linguistic groups.
My trip to Israel reflects this effort to bring the best expertise to YvY population. Researchers in
Tel Aviv, Bar-Ilan and Haifa have a distinguished research record on speech, language and literacy
development in children whose Home Language is not the default national language. Their expertise that complements mine will enable YvY Research Institute to develop tests and interventions
that best fit YvY population. How to convince top researchers from prestigious institutions to
bring their expertise and possibly their resources to YvY? A two-way approach: 1. present the
work that my past and current collaborators and I have been conducting for 15 years on the acquisition of different languages and demonstrate my ability to participate in international
projects and 2. describe YvY — a task facilitated by the very special YvY population and
the professionalism of all the YvY health and education service providers whose positive spirit crosses regional and national boundaries.
(continued on page 7)
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Name: Chaim Aronowitz
Job at YvY: Facility Maintenance
How long at YvY: Almost 3 years
Family: Wife, son, daughter (didn’t get the dog yet)
Biggest impact on me: My principal in Mesivta
Interesting trip: I drove to St. Louis with my brother on a business trip
In my free time: I like swimming and doing handy work
If I won the lottery…: I’d pay off my debts and take a long vacation
Favorite website / store: www.anywho.com / Starbucks, Dunkin Donuts
Volunteering done: I helped Tomche Shabbos org. with packages for the needy
I regret not having…: Gone to college to become a shrink
Public Speaking Experience:
Kiruv work in Ukraine

Major accomplishment:
Renovation of my home

Favorite food: STARCHES.
Breads, cakes….

Name: Melissa Pupko (Jablonsky, depends who
you ask)

Job at YvY: Service Coordinator for Early Intervention
How long at YvY: 2 years and a few months
Family: My husband Yisroel (named after the
Chofetz Chaim) and my daughter Chana

Biggest impact on me: My mom
Favorite food: Everything without onions
I’m famous for: My Butternut squash kugel
Most people don’t know: My maiden name is

Would like to visit
someday: Paris, Rome…
Most people don’t know:
I’m very very patient

Habit I wish I could get rid of:
Smoking

Pet Peeve — this irks me: Financial Debt
Special Talent: Singing
If I’ve learned one thing in life, it’s: “People
will ride all over you if you will let them.”

Jablonsky and not Pupko

Public Speaking Experience: At my brother’s Bar Mitzvah — I’m still traumatized
Relation to famous person: My dad is Douglas Jablon, Mr Maimonides!! Oh and my dad’s boss is best friends
with Robert Dinero’s wife

Would like to visit someday: Winnie the Pooh’s tree house
Habit I wish I could get rid of: Procrastinating
Game/Sport Expert: Volleyball. At Shulamith High School we won the championship
In my free time: I shop
Favorite store: Talking Fashion — when I still lived with my parents — obviously
Pet Peeve — this irks me: When someone crunches bags of potato chips
Special Talent: I could make my top lip and bottom lip go in 2 different directions!
If I’ve learned one thing in life, it’s: “Don’t sweat the small stuff” and “At the end of
the game, the king and the pawn go in the same box.”
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Direct Deposit Update

We are very pleased that the number
of employees who have signed up with
our Direct Deposit option is nearing
50%. This reflects the satisfaction that
employees are experiencing with this
very convenient benefit.

• Direct Deposit is safe. Direct Deposit
payments never get lost or stolen.
Furthermore, fraud is reduced because
there is less potential for counterfeit

checks, stolen checks, altered amounts,
and forged signatures.

and there is no waiting for a check to
clear.

• Direct Deposit is confidential. Money
is transferred electronically and passes
through fewer hands than a check.

• Direct Deposit is free. Get cash
without paying any fee at any Citibank
ATM or, very conveniently for our
BP staff, at our ATM machine in our
administrative building at 1450-37th
St. If you have not signed up yet for
Direct Deposit and would like to join,
please contact HR — Gitty at ext. 575
or Tzivie at ext. 561

• Direct Deposit is smart. It happens
automatically with each payroll,
giving employees instant access to
their money on payday on time, every
time. You don’t have to be at work, or
even in town, when a deposit is made

Many employees were thrilled to notice this full-page ad in major newspapers.
We reprint it here for those of you who missed it.

Always a Winner
at YvY!

Thank

Great
People.
Great
Accomplishments.
Great
Appreciation.
Yeled V’Yalda Salutes Our

FOUNDED IN 1981, HAS A LONG
AND DISTINGUISHED HISTORY OF
SERVICE TO CHILDREN AND
FAMILIES OF VARIOUS
BACKGROUNDS AND CULTURES.

Programs:

1,000+ Devoted Staff Members
For more than 20 years Yeled V’Yalda has been improving the
lives of families in our community. Our role continues to grow
every day, adding new services, new facilities and new ideas to
our wide range of offerings.
With thousands of families now benefiting from our educational,
health, nutrition, developmental, and social services, the Yeled
V’Yalda Board of Directors, Parent Policy Council and
Administration wish to acknowledge the source of our
tremendous success – our dedicated, talented and highly
professional staff & therapists.
To each of our 1,000 + employees, we say “thank you!” “Thanks
for giving your all!” Thanks for caring deeply for each child, each
parent and each life you touch. May we all merit the strength
and resources to continue in this vital work, and may our efforts
and yours be blessed with continued success.

QHead Start
QEarly Head Start
QHome-Based Head Start
QExpectant Moms Program
QDay Care Head Start
Collaboration
QHead Start/Special Ed
Inclusion Classroom
QEarly Intervention
QSpecial Education – Board of
Ed Contract Winner
QApplied Behavior Analysis
Program
QUniversal Pre-Kindergarten
QHealth Clinic
QVision Therapy
QHome and Community –
Based Rehabilitation Services
QWIC Program

Wishing you all and your families
a jna dj.

DESIGN: PAPERMASTERS / 718.854.1700

YELED V'YALDA,

E A R L Y

C H I L D H O O D

C E N T E R

718.686.3700

you all for contributing to
our Tech Talk column by submitting
your computer-related questions.
We were besieged by entries (the
superb ipod prize that was offered
certainly helped things along…),
and we present a few Q and A’s
here. We will continue to print
additional questions in future issues;
therefore, you can continue to
submit tech questions by emailing
YvYink@yeled.org.
The drawing for the iPod Nano
was conducted by Wayne Goldberg,
Director
Federal
HS,
Tuesday,
November 7th in the conference room
at 1450 37th Street. To the delight of
all, the winner was Ariela Landsberg,
Mr. Igel’s most devoted Executive
Administrative Asst. Congratulations
Ariela and Happy Listening!!
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Staff Development
YvY Research Institute:
Dr. Garey V. Ellis, Director of Health
Initiatives and Family/Community Partnerships gave a presentation on “The Prevention of the Increase of Obesity Through a
Culturally Appropriate Preschool Intervention” on Sept 29 at the NY Research Obesity Center, Columbia.
Isabelle Barriere, Ph.D., gave presentations on “Cross-linguistic, Cross-modal
and Bilingual Perspectives on Early Morphosyntactic Development: Educational
and Clinical Implications” at Tel Aviv and
Bar Ilan Universities on Oct. 23 and 24.
Isabelle also participated in the 31st
annual Boston University on Language
development conference, Nov 3-5. Isabelle attends CUNY graduate school
seminars on language on a weekly basis.

Staten Island:
Musarath Ansari has been promoted
to Toddler Teacher.
Ana Jain received her BS in Early
Childhood.
Melody Lenza, Janine Geritano, Ana
Jain, Lisette Robert, Debra Brown and
Veronica Hynes attended the Head Start
Regional Conference in Atlantic City:

Staff Workshops:
“Generating Fluent Speech: A dynamic
Stuttering Therapy” presented by Barbara
Dahm CCC-SLP BRS-FD 11/06 Young Israel
of Midwood

Ezra Celebrations:

Baby Boy – Lazer Dovid Friedman,
Dr. Eisenberg
Baby girl – Basya Ungar, Miriam Rosenberg,
Tamy Skaist, Shoshana Friedman
Dr. Gelfond received her fellowship in
COVD

Other:

Congrats to John Telenko (SI) on his
summer tour of Japan with his band,
The Amber Jets. Way to go, John!

Condolences:

YvY extends its sincerest condolences
to Tzivie Marder (BP) on the passing
of her father, to Esther Szanzer (BP)
on the passing of her mother, and to
Jeanette Whitcroft (SI) on the passing
of her son-in-law, Robert Wooley.

Mazel
Tov!
YvY Celebrations

Engagements:

Turty Green (BP) upon the engagement of
her son Hershy to Ruchy Heimlich
Chana Rivkin (BP) upon the engagement/
marriage of her son
Malky Schonberger (BP) is engaged
to Ephraim Haberfeld.

Vicki Edelstein (BP) upon the engagement of
her daughter Adina to Yanky Brachfeld
Rochel Kenigsberg (BP) on the engagement
of her daughter Bracha to Avram Moshe
Goldsweig
Susan Russo (SI) upon her engagement to
Chris DiGregorio

Marriages:

Moshe and Nechama Itzkowitz (BP)
Malky Geiger (BP) – Grunfeld
Blimie Feig (BP) – Moster
Dena Kasten (F) – Kanarek
Sussie Fisher (BP) – Tannenbaum

Ari and Chana Leah Unger (BP)
Simi Schlafrig (BP) on the marriage of her
daughter Roizy to Yisroel Bornstein
Devorah Meyer (BP) on her son’s marriage
to Raizy Pearl

Births:

Batya Moskowitz (BP) – girl
Chana King (BP) – girl (after 3 boys!),
Rivka Basya
Ora Goldstein (BP) – boy
Hindy Pachtinger (BP) – girl, Tzirel
Goldy Mandelbaum (ABA) – boy
Mr. Singer – boy
Malky Gips (BP) – boy
Sarina Kurtz (WIC) 8/27/06 – boy
Yitty Kirschner (SEIT supervisor) – boy,
Eliezer Yehuda

Gitty Bronstein (BP) – girl
Ruchie Bineth (BP) – boy
Tova Travitsky (BP) – boy
Winter Emery (SI) – boy, Jaedon
Oops… Mazal Tov to Tzivia Konstam (BP)
and Rivky Moskovitz (BP) whose birth
announcements we inadvertently omitted
in our previous issue.
Congratulations to Expectant Moms… Jaclyn
Nicole Hunt (SI) and Hilda Valentin (SI)

Chaya Kagan (BP) – grandson
Mrs. Aggie Lemmer (BP) granddaughter
Rochel Terkeltaub (BP) granddaughter
Rabbi & Mrs. Szanzer (BP) grandson
Janie Friedman, R.N. – granddaughter
Leah Lieman (BP)

Gitte Srulowitz (BP) grandson
Rochel Rosen’s (BP) daughter Peshy
Frenkel – girl
Gitty Lichtenstein (HR) – granddaughter
Veronica Hynes (SI) – grandson, Michael

Proud Grandparents:
Bar/Bas Mitzvah:

Edith Schaffran (W) on the bas mitzvah of her granddaughter Rachel
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H

RUSH HOUR

ere are some of the comments we got in response to our survey question:

What is the first thing you do
when you leave (or get home from) work?

• I get down on the floor with my 18-month-old and try to make up for the time
we are not together.
• First thing I do is change what I'm wearing — I can’t do anything until I'm in
home gear.
• I take a gulp of fresh (???) Brooklyn air as there are no windows anywhere in my
office building.
•
home! If I get to throw off my shoes and sheitel, I’m a lucky person. To use the
bathroom — that’s a bonus — I try to do that before I leave the office…
• I check the mail and the answering machine.
•
cozy, comfortable, lounging-around-the-house clothes.
•

first thing I do when I leave my house is check that I’ve taken my cell phone
— many times I have to make an about face and head back to the house for the
get home is prepare an iced coffee with ice cubes to drink while I get dinner ready.

•
tell me about how he traded his lunch for a _____ (fill in the blank), the 5-yearold wants to show me his painting (which is on his brand new shirt despite the
smock), the 2-year-old is
kvetching to be picked
up and the baby wants to
nurse. But, thank G-d;
I wouldn’t it any other
way.
•
I get home from work
is to plop down on the
couch with my 2 kids
and just relax.
•

I kick off my shoes and
unwind on my porch
swing.

•

I go to the supermarket
where I bump into my
YvY workmates!

New Faces YvY
Serel Bakon (BP) Quality Assurance
Toby Barski
(BP) Asst. Teacher
Meira Benjamin (BP) Service Coord.
Ruth Berelowitz (C)
Teacher
Rachel Berezin (BP)
Secretary
Sara Elky Blau (BP) Quality Assurance
Yonina Bomzer (BP) Service Coord.
Elka Bromberg (F)
Teacher
Joseph Cardone (SI)
Bus Driver
Miriam Dahan (C)
Teacher
Catalina Deflorio (SI) Family Worker
Monica Deitz
(C)
Teacher
Aliezer Einhorn (BP) Transporter
Baila Ettlinger (BP)
Teacher
Jessica Fallon
(SI) Family Worker
Raizy Freeman (BP) Asst. Teacher
Yehoshua Geller (BP)
Custodian
Connie Girardi (SI) Home Visitor
Rivky Gleiberman (BP) Record Clerk
Tsirel Gold
(W)
Secretary
Leah Goldhirsch (W) Asst. Teacher
Devorah Greenberg (BP) Asst. Teacher
Shevy Grossman (BP) Graphic Artist
Lillian Hall
(SI) Home Visitor
Farrah Hammer (WIC) Nutritionist
Gitel Herbst
(WIC) Record Clerk
Malka Horowitz (BP) Record Clerk
Ita Kanarek
(F)
Teacher
Matty Katz
(BP) Home Visitor
Chana S. Kornfeld (BP) Family Worker
Sarina Kurtz (WIC) Nutritionist
Roizy Kuten
(BP)
Secretary
Rivkah Laufer
(BP) Asst. Teacher
Shprintzy Lieberman (W)
OT Supe
Hadassah Light (BP)
HR Coord.
Patricia Maresca (SI)
Teacher
Zissy Mayer
(W) Asst. Teacher
Chava Menzer
(BP)
Secretary
Rachel Myski
(W)
Teacher
Dagmar Nunez (SI) Asst. Teacher
Fraidy Orgel
(BP) Family Worker
Melissa Ortiz
(SI) Record Clerk
Lea Pesach
(F)
Asst. Teacher
Milka Pilchik
(BP) Disabilities
Coordinator
Devorah Rabinowitz (BP) Record Clerk
Matie Rubinfeld (W) Seit Supervisor
Toni Scarpati
(SI)
Teacher
Karen Scheinberg (all sites)
Asst. Deputy Dir. of Social Services
Devorah Schwei (BP)
Teacher
(continued on page 7)
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From the Desk of… (continued from page 2)
The needs of YvY population are not limited to language: the medical expertise of Dr Ellis is needed in order to enhance mental health services
and tackle serious health issues. With respect to the former, the YvY Research Institute
has initiated an effort with the Institute of Adolescents, Child and Family Studies, an
organization based in Manhattan the mission of which is to make parental support
available to low income families. In addition, following a meeting initiated by D. Ackerman, Education Director of the ABA program, Dr Ellis has secured a partnership
agreement with H. Abikoff, New York University Child Study Center: pending positive outcome of an application to the National Institute of Mental Health, families of
YvY children with attention disorders will benefit from a parental intervention.
One of the serious health issues that are currently plaguing the US, including YvY population, is the risk of obesity. YvY Research Institute was invited to
present the current facts about YvY population and discuss possible collaborations with New York Obesity Research Center, Columbia. The different doctors
there (PhDs and MDs) showed much interest in bringing their expertise to YvY.
The Research Institute whose approach is to conceive projects that reflect the
mission of YvY- serving children and their families while respecting each one’s
cultural heritage- has also had fruitful interactions with the Brooklyn Conservatory of Music with a view of developing culturally appropriate music education
programs combined with dance — i.e. reinforcing an already existing cultural
behavior in order to improve children’s health.
For 25 years, the philosophy of YvY “a child deserves the best” has been applied to the implementation of education and health services. The mission of the
Research Institute is to ensure that YvY children and their families also benefit
from the best research currently available to further enhance these services.

Isabelle Barriere, Ph.D.
Director, Policy and Research for Education

For your convenience

Yeled v’Yalda has recently acquired
an in-house graphic designer.
For all your design needs

If you need fliers, advertisements,
or any other project
requiring graphic design,
please send full details
to Elisheva Grossman:
art@yeled.org

At 99 Heyward, Bassie Morris presented a Parenting Workshop on “How to Talk So
Kids Will Listen.” About 50 women from EHS
and HS attended, and there was a spirited
discussion. The event was culminated by a
surprise goodbye party with ice cream cake
for Bassie, who will be transferring from EHS to
work exclusively with HS.

New Faces (continued from page 6)
Malka Spira
(W) Asst. Teacher
Faigy Twersky
(BP)
Teacher
Chana Ungar
(W)
Custodian
Meyer Unger
(BP)
Aide
Ricki Wegh
(BP) Record Clerk
Miriam Weinstein (BP) Family Worker
Frady Zeidman (BP)
Teacher
Giti Zelmanovitz (BP)
Family &
Comm. Partnership Coord.

New Faces at
the YvY School
Esther Cohen
(BP) Asst. Teacher
Basya Fass
(BP) Asst. Teacher
Judith Fasten
(BP) Asst. Teacher
Rivka Fishman
(BP)
OT
Frumie Friedman (BP) Asst. Teacher
Nechama Goldblatt (BP) Asst. Teacher
Chumie Kaszovitz (BP) Asst. Teacher
Etty Kotler
(BP)
Teacher
Rochel Newman (BP) Asst. Teacher
Toby Pinter
(BP) Asst. Teacher
Cori Regan
(BP) Speech Therapist
Faigy Schachner (BP)
Teacher
Malka Taitelbaum (BP) Asst. Teacher
Hennie Thau
(BP) Family Worker

We’re
Listening…
YvY wants to hear what you
have to say! Due to its rapid expansion, YvY recognizes
a growing need to establish a
broad-spectrum
HELPLINE
whereby staff, parents, therapists and the general public
can call to lodge complaints,
ask questions, offer suggestions, or
express their satisfaction. In addition,
this Helpline will ensure that every call
placed to YvY will receive a speedy
response. This initiative stems from a
strategic effort by YvY to further enhance the flow of communication
among the numerous departments
at Yeled V’Yalda and with our community and family partners. Details
will be forthcoming.
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TECH TALK
Are there differences between
Windows 2000 and XP? When
should it be upgraded? What capabilities am I missing?
A.W. Administration
•	Windows XP is somewhat faster than
Windows 2000, assuming you have
a fast processor and tons of memory.
•	The new Windows XP interface is
more cheerful and colorful than
earlier versions, although the lesscartoony “Classic” interface can
still be used if desired.
•	Windows XP has more bells and
whistles, such as the Windows Movie
Maker, built-in CD writer support,
Internet Connection Firewall, and
Remote Desktop Connection.
•	Windows XP has better support for
games and comes with more games
than Windows 2000.
•	Windows XP is the latest OS
(Operating System) — if you don't
upgrade now, you'll probably end up
migrating to XP eventually anyway.
“Cookies” — can you please explain
what they are?
A.L. Administration
A cookie is information that a Web
site puts on your computer so that it
can remember something about you
at a later time. Typically, a cookie
records your preferences when using a
particular site. Cookies are commonly
used to customize pages for you
based on your browser type or other
information you may have provided

the Web site. But, in general, cookies
help Web sites serve users better.

instead of manually repeating the
commands.

How do I set up my name/title/contact
info so that it goes onto each e-mail I
send without writing it each time?
R.K. EHS

How do you stop pop up ads from
coming up when you’re on-line?

This is called a signature… Here are
the steps for Outlook (in other versions
the steps might be a bit different). In
the main Outlook window, select from
the menu: “Tools > Options > Mail
Format > Signatures”. Click the
“New...” button, and give your signature
a name. Select “Start with a blank
signature” if this is your first signature.
Follow on-screen instructions.
What are Macros?
D.W. Bookkeeping
A macro is a way to automate a
task that you perform repeatedly
on a regular basis. It is a series of
commands and actions that can be
stored and run whenever you need
to perform the task. You can record
or build a macro, and then play the
macro to automatically repeat the
series of commands or actions. These
tasks can be something simple from
inserting your name and address into
a word processor to something more
complex such as launching a program,
copying data from it, activating
another program, pasting the data
into it and repeating this several
times. Tasks performed by macros
are typically repetitive in nature, so
time is saved by executing the macro

D.R.. Bookkeeping
If you have Windows XP and you
installed service pack 2 it includes
a popup blocker. Open Internet
Explorer. On the Tools menu, point
to Pop-up Blocker, and then click
Pop-up Blocker Settings. You can also
download Google’s or Yahoo’s tool bar
which includes a popup blocker.
Why would a computer need to
renew an antivirus subscription if
you are still able to do a file scan
with an expired subscription?
H.L Administration
The way an anti virus program
works is that it will scan your computer
based on a file that has the latest
virus signatures on it; if it finds a
match on your computer it knows
it’s infected. If you don’t have a
subscription you won’t get the updated
signature file and it will only
know to compare it to
your old file with old
virus definitions and
any new viruses will
not be detected.

By Ari Ungar
A+, MCSE
Certified

We’d love to hear from you!
We would like to thank everyone for their input, encouragement, and suggestions for the newsletter. Please be advised that due to editorial content, time and/or space constraints, it is not always possible to include all submissions. At the same time, however, we would like to
encourage you to continue writing us. Look for our next issue in the winter! Please e-mail your comments, suggestions, letters to the editor
and news to YvYink@yeled.org or to rherbst@yeled.org or fax to 718.871.2100

